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Edgewood Elementary 
Mac Lab/Mac Student Computer Software Descriptions 

 
 
Desktop Icons: 
 
Macintosh – This is the hard drive of the computer where all of the software is loaded.  Students and 
staff should not open this.  It is for only technicians and lab supervisors. 
 
Launcher – This is the user friendly listing of all of the software on the computer.  It is called a 
“Launcher” because when you click on one of the program icons, the computer “launches” or starts up 
the program.  Note that the Launcher icon button is red and is meant as a “computer safety net” in case 
a child closes the window of the Launcher.  If this happens, merely double-click on this Launcher icon 
and the Launcher window will reappear.  The Launcher is divided into several menus: Applications, 
Communications, HypterStudio, Kindergarten, and Math.  Each of these menus and their related 
programs are discussed below. 
 
Trash – This is the Mac Trash Can which is used to store documents no longer needed.  If you go to 
the Special pull-down menu, you can “Empty Trash” which permanently removes documents from the 
computer.  This is similar to the Recycle Bin on the P.C. 
 
 
Applications: 
 
Acrobat Reader - This free program is used to open pdf or portable document files created with the 
Adobe Acrobat Software.  Most common pdf files are found on the Internet.  It is not a student 
program per se, but a necessary piece of software for opening up pdf files.  It works transparently 
behind the scenes when you double-click on a pdf file downloaded from the Internet.  A pdf file can be 
read by any computer platform (PC or Mac) if the free version of the Adobe Acrobat Reader is 
installed on the machine.  For example, the weekly EWE calendar is a pdf file which is read by the 
Adobe Reader Acrobat software. 
 
AppleWorks - This is one of a few programs which is cross platform.  That is AppleWorks is installed 
on all campus Macs as well as the PC’s.  If you wish to do a cross platform project...i.e., work on both 
the PC laptops as well as the student Macs and/or Macs in the labs, then choose AppleWorks.  It has a 
suite of three useable applications: word processing, data base, and spreadsheet.  In the Microsoft 
world, the same suite is available as Microsoft Works.  Students from grades 1-5 can easily adapt the 
word processing module of AppleWorks into their core curriculum.  Products including poetry, letter 
writing, and report writing are all easily done in the AppleWorks word processing module.  Student 
data collection can best be done in the AppleWorks spreadsheet module.  Finally, if you wish to keep 
track of inventory items or categories of information, the data base module is the best choice. 
 
AR Student – Used by students to take Accelerated Reader Tests.  The student must use their student 
I.D. number to access this program.  This school year, our district will be migrating to the new web 
based Accelerated Reader Program which will make this application obsolete. 
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AR teacher – Used by the classroom teacher to print reports including class rosters and student 
progress reports for tests completed.  See the Librarian for the password to access this application. This 
school year, our district will be migrating to the new web based Accelerated Reader Program which 
will make this application obsolete. 
 
Kid Pix – Our all time favorite for many projects from PreK – 5.  Remember, there is a slide show 
program within Kid Pix allowing multimedia productions including the inclusion of sound and 
photographs as well as pasted work from an AppleWorks word processing document.  The 
Kindergarten section of the Launcher uses many PreK/K templates and lessons for use in Mac Lab #3 
during Specials Time. 
 
Kid Works 2 – A PreK/K program loaded on some of the Macs…can be loaded on any machine 
because we have a site license.  This is an exploratory program for early learners including a 
sound/rebus option for creating stories.  It also includes beginning basic drawing tools. 
 
My Own Stories – An older program for constructing stories.  It requires the monitor to be set at 256 
colors…most in the labs are set at thousands of colors for better viewing of Internet pictures and digital 
photos.  It has the major components of making a story.  For example, title, author, and content are 
included as well as basic drawing tools.  You can save, retrieve, and finish as you have time.  Finally, 
components of reading and printing stories are included.  The best strategy is to have a story or story 
ideas ready before using this program with students. 
 
Once Upon A Time, 1 – This program allows you to create a picture with various graphics and 
drawing tools.  At the bottom of each page, you may add text.  The nature of this application is that it 
treats visual objects and text as coexisting parts when writing stories. 
 
Once Upon A Time, 2 – The Part II program allows you to create a picture with a different set of 
graphics.  At the bottom of each page, you may add text.  The nature of this application is that it treats 
visual objects and text as coexisting parts when writing stories. 
 
Puppet Playhouse – This is an older program from 1991 which allows you to print puppet 
backgrounds and to print 2-sided puppets for use in storytelling and creative dramatics in the PreK-2 
classroom. 
 
Social Studies – This is our new program entitled “Exploring Where and Why.”  It has been installed 
on all campus Macs.  This is a great program for learning basic geography concepts for grades 2-5. 
 
Storybook Weaver - An older program for constructing stories.  It is similar in operation to “My Own 
Stories.”  It requires the monitor to be set at 256 colors…most in the labs are set at thousands of colors 
for better viewing of Internet pictures and digital photos.  It has the major components of making a 
story.  For example, title, author, and content are included as well as basic drawing tools.  You can 
save, retrieve, and finish as you have time.  Finally, components of reading and printing stories are 
included.  The best strategy is to have a story or story ideas ready before using this program with 
students. 
 
The Print Shop Deluxe – This is a classic and is available only in the Mac Labs because of licensing 
restrictions.  However, used in the right context, you and/or your students may create cards, signs, or 
banners according to your classroom content. 
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Thinkin’ Things, Collection 1 – This is available only in the Mac Labs.  It is a great sequencing and 
visual organization tool for PreK-2nd grade.  It has won numerous awards and is very engaging even 
for older students. 
 
TimeLiner 5.0 – This is a wonderful tool for Social Studies or any content area where you wish to 
publish a timeline of events.  There are many sample templates and ideas from our staff for utilization 
of this within the K-5 curriculum. 
 
Type To Learn – This is a stand-alone program on every Mac computer on campus.  It is used by 
many staff to teach keyboarding skills.  Since it is an older program, it is not a networkable 
application.  This means that the program resides on the hard drive of each Mac.  Therefore, you must 
set this program up for each student.  However, the benefits in keyboarding progress are worth the 
upfront setup.  Option-Command-T gives you the Teacher pull-down menu.  From there, you can set 
up a class and students for assigned computers in the lab or a rotation within your classroom (i.e, half 
your class on one student Mac and the other half on the other…then, use a daily/weekly rotation 
schedule).  Later this school year, our district will be migrating to the newer version of Type-To-Learn 
and will be available via a network server.  This means that your students will be able to access their 
progress file from any computer on campus. 
 
Communications: 
 
ClassWorks – This is a large network program for use in helping students deficient in a variety of 
content areas.  However, at this time, it is not available on our campus network due to unavailable 
upgrades to match the state of Texas TEKS. 
 
Internet Explorer – We recommend using the Macintosh version of Internet Explorer with your 
students since many sites are “intertwined” with these Microsoft browser components.  Using the style 
of Macs we have on campus (soon to be upgraded to all G3 machines) has some quirks on PC based 
web pages.  For example, on our home page the banner does not replicate as accurately as on a PC. 
 
Netscape Communicator – This used to be the standard browser for Macs.  It is still usable…but, see 
the information about IE above. 
 
PictureViewer – This is a free program which allows you to view and size digital images before 
printing them. 
 
TIFF Grant – This is the access point for our student saved files.  Remember the password is TIF.  
Once opened, there is a folder for each grade level, teacher, and student to store files or work in 
progress. 
 
HyperStudio: 
 
Home Stack – This is a true multimedia program designed like a stack of index cards that are 
connected with electronic buttons.  The “Home Stack” is one way of beginning this program. 
 
HS Manuals – These are imbedded manuals on how to use this program with students. 
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HS Samples Library – The “HS Samples Library” is a good beginning point in viewing student 
projects completed by other teachers. 
 
HyperStudio 3.3 – This is the main application program for HyperStudio.  We have many ideas and 
templates used in the past with our students and staff at EWE.  Check with your Technology Specialist 
on template ideas as related to content.  This product lends itself nicely to both Science and Social 
Studies curricula. 
 
Kindergarten: 
 
Series of Templates/Lessons – These templates were created during the 2003-2004 school year in 
collaboration with the Kindergarten Staff and other personnel.  Explore to see if any of these will work 
with your students.  Many lessons on sequencing and patterns are included.  These are appropriate for 
PreK, K, and the beginning of 1st grade. 
 
Math: 
 
Fraction Munchers – This is a great program that can be modified and customized for your students 
in their practice of fraction concepts.  Go to the Management pull-down menu and select Enable 
Management.  The password is “Athena”  Now, you will be able to customize the content and clear the 
“Hall of Fame.”  Leave the “Network…” and “Change Password…” section alone!  When done and 
before using with students, “Disable the Management” options. 
 
Geometry Vol. II – This is one of four Math Keys programs SBISD owns.  Geometry, Volume II 
includes Pattern Blocks, Shape Blocks, Geogrid, and Mirrors.  You can choose either English or 
Spanish.  It is a great follow-up to hands-on activities already conducted in the classroom. It is not 
intended as a substitute to such equipment as pattern or shape blocks.  Rather, it is a supplement.  We 
have detailed information on each component of Math Keys and can offer training if there is enough 
interest as we have done in the past. 
 
Math Blaster – This is a classic for drill and practice of basic math facts.  Be sure to familiarize 
yourself with the Activity pull-down menu where you can view the problems and well as the problem 
format.  Students should be directed to choose both the Subject and Level through those respective 
pull-down menus.  On individual computers in the classroom, the File pull-down menu allows the 
teacher to view records and print reports of students’ progress. 
 
Math Blaster Mystery – This is a wonderful program for story problem solving strategies.  Be sure to 
read the Instructions under the Help pull-down menu.  Like Math Blaster, there is a built-in record 
keeping module.  There are four components in Math Blaster Mystery…Follow the Steps, Weigh the 
Evidence, Decipher the Code, and Search for Clues. 
 
Number Munchers – This is similar in nature to Fraction Munchers.  This involves only whole 
numbers including prime numbers.  The password to “Enable Management” is “digit” 
 
Probability Vol. I – This is similar in scope to “Geometry Vol. II” above.  The components are Coins, 
Cubes, Spinners, and Marbles.  All of these components are excellent reinforcement to elementary 
probability studies. 
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Probability, Vol. II – This is a more advanced module that would fit high 5th and above.  The 
components are Coin Machine, Number Machine, Spinner Machine, and Mystery Machine.  Again, all 
of these components are excellent reinforcement to elementary probability and statistics studies. 
 
Sequencing Fun! – This program is installed on all of the Macs in the computer labs.  It is appropriate 
for beginning sequencing activities beginning in K and through the primary grades.  Included are 
randomizers with either video or cartoon clips making the games engaging and productive for the early 
learner. 
 
Talking NumberMaze – This older program talks to the student as they traverse a maze.  Be sure to 
use the Help pull-down menu and read “Information” to find out more about the program.  Work with 
students the first time they use this program.  They should log-on as a new student using both their first 
and last name (use the projector in the lab to illustrate this…).  When students use this procedure, they 
can choose the correct pronouns of “she/her” or “he/him” for use within the program when it “talks” to 
them.  The next menu allows you to choose both level of difficulty as well as curriculum.  When used 
correctly, this can be an excellent tool for review of previously taught math concepts in a game arena. 
 
Treasure MathStorm – This is an all time favorite at EWE because of the obstacles and adventures 
encountered when trying to find the “treasures” on the mountainside.  Once you are past the new 
player log-on, be sure to review the Customization and Help menus.  This program automatically 
advances students to harder levels as they successfully complete a current level. 
 
Whole Numbers, Vol. I – This is a beginning module for Math Keys.  It focuses on Base-Ten Blocks, 
Hundred Chart, Counters, and Money.  Again, this should not take the place of read base-ten blocks, 
etc.  The emphasis of this module is beginning whole number concepts.  This would be appropriate for 
K and grade 1. 
 
Whole Numbers, Vol. II – This is the second module with the same components as Volume I, but at 
more difficult level.  This would be appropriate for grades 1-3. 


